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Welcome to M365 OneNote and Planner

CLOSE EMAIL BE CURIOUS
They'll be there for you Ask questions and be interesled
later. in what others have to say.

RAISE YOUR HAND

Raise your hand for real, or
virtually, or post a smiley face or
thumbs up

Q ENGAGE

Participate and engage with
others. It may not be your

L o j'n?} thing, but it may help them to
- - S learn.
PHONE AWAY ;_ 2

BE PRESENT

Multi-tasking is a myth

Move it out of reach so
you won't be distracted

TAKE NOTES SUGGEST IT
Capture important key If you have any great
points as you learn. ideas, share them.




What You’ll Learn Today

Overview of Microsoft OneNote and Planner

* Topics covered include:
* Overview of Microsoft OneNote
* Notetaking Best Practices
* Overview of Microsoft Planner
» Benefits of using Planner for task management



Lesson 1

Introduction to
OneNote in M365

« Define Notebooks, Sections, Pages, and Tags !
* Create, Organize, and Search Notes Within a OneNote Notebook



Examples of OneNote Notebooks

* Project Overview
 Meeting Notes
 To-Do List

* Daily Work Schedule
 Weekly Planner

* Quarterly Planner

* Time Management
 Work Notebook



OneNote Structure

Typical Notebook Structure OneNote Notebook Structure

i

Notebook

vai Michele @ Work » EJ" Add Page ~L'-_

0365 Project ¥ Kick-off Meeting

> Discovery Meetings

Section

¥ Internal Status Meetings

v (Client Status Meetings

Project Updates

Pages Weekly Status Update

Weekly Status Connect

Weekly Status Connect

Weekly Status Connect

Sub-pages




Accessing OneNote

< @ Apps Documents Settings Folders Photos

From the Desktop
1. Type OneNote into the Windows search bar. q
2. Click Open. = o

Apps OneNote
App

Best match

N:_ OneNote for Windows 10

n Sticky Motes (new) ?  Open
Folders MNew Sticky Note

*  Mew quick note
BE OneNote Notebooks

Take screen clipping
BB OneNote RecycleBin
Documents
ﬂ OneMNote DeletedPages.one

B




OneNote Navigation

File  Home Insert Draw History Review View Help

Menu Tabs

-— 1= = o= . 1 8~
ﬁj ED Calibri “ 11 vi= v iz v | I= 2= ﬁo Headmg 1 B To Do {Ctrl+1) V EO\ FD @ @" .
— = ind look il i i
Paste Sromarine | © L L K £ Av =~ Heading 2 K Important (Cul+2) k;azo ::;s st i;nga; pets | Rlbbon
Clipboard Basic Text Styles Tags Email Meetings Viaice
Notebook
Motebooks » Development Schedule +
> [ Michele @ Work = = 1 i
B vicreo v I v Vertical Section Tabs

Individual Productivity

v [l oses v Course Outlines Friday, February 28, 2025  12:06 PM H . I S . T b
Individu Productiviy orizonal Section labs
Development
o How to Store Documents
: P d sub-
B Working Better with My Team @% ages a n Su pa ges
i Weekly Updates v Course Presentations PWM Indi

N o bk wDd R

Page content

Individual Productivity Productivit...
i My Team Notebook




Creating a New Notebook

File fHome Insert Draw History Review View Help

[

Paste [D
‘3 Format Painter
cptesre @ New Notebook
Info .
(O Recent @ OneDrive - TNAOC
) New : Recent Folders
= @ OneDrive - TNAOC ‘
i D Notebooks
Q Sites - TNROC OneDrive - TNAOC » Notebooks
Save a Copy i root
FLJ This PC D OneDrive - TNAOC
Print =
o
Share Add a Plage lz(hi,
Browse
Export / Browse
v [l ThisPC

» 15 Windows (C:) — 1

»  wg 52711 _USERS.27c.ib (\bt) (H:)

Notebook Name: ‘

Save as type: OnelNote (".one)

~ Hide Folders 9 Cancel

To create and save a New
Notebook, you must first

choose a location for it to
be stored in.

1. Select File
2. Click New

3. Select OneDrive >
Notebooks or Browse.

4. Name the Notebook,
then click Create.




Lesson 1

DEMO - Introduction to S
OneNote in M365

Notebook Structure
 Ribbon

« Search

* Share

» Create a Notebook

* Add Section, Pages, Sub-pages
* Note Content




AR A

Notebook Structure

Notebook
Section

Page

Sub-pages
Note Content

Motebooks

> [

Michele @ Waork =

<@

0365

Development Schedule +

[ Add Page JF

w Course Outlines |e

Development

v

Schedule

Woeekly Updates

Week 1

Mew Section 1

Individual Productivity

How to Store Documents e

Working Better with My Team

w Course Presentations

Individual Productivity

©

Individual Productivity

Friday, February 28, 2025 12:06 PM

[

PWM _Indi...
Productivit...




The Ribbon

File Home Insert Draw History Review View Help
O Cut N — == . (] +1) [ P —3
ol Calibri v11 vi=vi=~ =3 A Heading 1 i ¥ Do oae) V| 8 PJ @ QJ
Ié'. (B copy - X gt I ) M T_D Fi ;\ Outlook Ermail MI_ i Di
aste = i i r K —| o Do in utioo mai eeting ictate
<& Format Paintes BIU®x- A= X Heading 2 i Question (Ctrl+3) "l Tag Tags Tasks~ Page | Details v
Clipboard Basic Text Styles Tags Email Meetings Voice

* Format your page.
* Use Dictate to add text.




Search

Individual Productivity

| Development
How to Store Documents

| Sschedule
Working Better with My Team
~ Course Presentations

v ii Weekly Updates
Individual Productivity

' New Section 1

[
ms

PWM_Indi...
Productivit...

File Home Insert Draw History Review View Help [# Sticky Notes
— = R 8 D
Calibri = = = %A Heading 1 [] To Do (ctl+1) iQ FD ) )
Paste B I U a6 x ~ £+ A . =. . ¥ . X To Do Find Outlook Email Meeting | Dictate
v < Format Painter - ‘ - - Headmg 2 Important (Ctrl+2) Tag Tags Page Details +
Clipboard Basic Text Styles Tags Email Meetings Voice
MNotebooks » Development Schedule + Q Search Notebooks
» i Michele @ Work  » o Addn E
d Page ; .. A
Individual Productivity
~ ii 0365 v Course Qutlines Friday, February 28, 2025 12:06 PM




Share

OneNote offers multiple ways to share your notebook.

File Home Insert Draw History Review \View Help

o = — | - . a—
o Calibri v M= iE ey = E A Heading 1 [v] ToDo(culin B 2 Q FD @ QJ P2
Paste . . = X = . | ToDo Find Outlook Email Meeting Dictate 1
¥ <F Format Painter B I U x £ - - Headmgz W Important (Cul+2) Tag Tags Tasks v Page Details ~ 5 S.ha”: Entl'E NGtEbDGk
Clipboard Basic Text Styles Tags Email Meetings Vaoice ~
C@» Copy Link to Notebook ;
Notebooks » Development Schedule o+ F :
> ii Michele @ Work  » - i s
O Add Page E - . (=1 Email Copy of Page
c Individual Productivity
v W 0365 ~ Course Oullines Friday, February 28, 2025 12:06 PM @}
' ' Manage Access...

' Development Individual Praductivity
How ta Store Documents
[

' Schedule -
Working Better with My Team mE

v i Weekly Updates ~ Course Presentations PWM_Indi...
Productivit...

' New Section 1 Individual Productivity




File Tab

Notebook Information

Click the File tab to open other notebooks,
export, share, export and much more.



Create a Notebook

File Home Inser|

1. Click on the File tab.
a 2. Select New to display the New Notebook

®© New Notebook

.
63 tnfe @ Recent @ OneDrive - Insight O ptl 0 n s °

| [ New Recent Folders
@ OneDrive - Insight
&5 Open D Documents H
oose Unebrive
Sites - Insight . .
ht » Notet s

"""" = [] Notebooks -
e E@ This PC OneDrive - Insig|

Share |
- e d 4. Follow the prompts for the location you
Send = Browse Bituen ‘ ™ personal > michele_medgaus insight com » Documents > Notebooks » v 0| s htaasis 5

chose.

i
(-]

o i e 5. Name the new notebook and click Create.




Create a Notebook

1. Once the notebook has been created, it displays
in your list of notebooks.

Notebooks » New Section 1 4

> B Michele @ Work i
i IESE S il C [ Add Page IF

2. Each new notebook contains one section which
contains one blank page.

' Development
' Schedule
°‘-n= — 3. Right-click on the new section and select
] y Updates /
P

v [l o Untitled page

a

(ot 2 Rename from the menu.

Ejl Rename B
Epore 4. To change the color of the section, select
X Delete °
) Section Color.
B Move or Copy... [ ewe
[a Merge into Another Section... u :_T::: ) ii Michele @ Work =
[2 Copy Link to Section W ke
N New Section : ::IE ? i 0365
WM New Section Group M Orange
) Password Protect This Section... : ZT::: N New Section

/l Section Color > W Purple Mist ll New Section Group

Ia B New Notebook...
o e It is also possible to create a new notebook by Open Notebook.
right-clicking in the Notebooks navigation pane

and selecting New Notebook from the menu.




Add Sections to a Notebook

There are two methods for adding a new notebook section to a notebook:

1. Right-click in the Notebooks navigation pane and select New Section a S

rI Mew Section Group

2. from the menu.

El Mew Notebook...

OR EI Open Notebook... a
2. From the horizontal tabs, click the + on the blank tab. Notebooks + |
» iE Michele @ Work = .
[ Add Page
¥ ai 0365 Untitled page
A new section tab displays with the placeholder's name New Section. { evsopmen

l Schedule

You name the new section by right-clicking the new section and selecting Rename.

L ni Weekly Updates

| NewSection 1
Notebooks » Week 1 New Section 1 +
> H i (o
i. Michele @ Work & Add Page F
> [ o365 Untitled page
v n’. Weekly Updates
[ week1
l New Section 1 ";ENNESSQ\




Add Pages to a Section of a Notebook

Notebooks » Week 1 New Section 1 +

1. Click Add Page.
> [l o365 Activities for Week

To add a page to any section
e sinichit E _ d éActivit'es for Week 2

Activities for Week 2

2. Enter the page name on the top linein |
the main panel. ( week

l MNew Section 1

Once you add the page, the untitled page shows up in the Pages list and the cursor is automatically at

the top of the page in the main panel.
As you start typing the name, the title shows up in the main panel.




Add a Sub-Page to a Notebook

A sub-page in OneNote is a secondary page grouped under a primary page within a section of a

notebook.
. Week 1 New Section 1 ¥+
Open the section where you want to create the e m
Su b'page. v Activities for Week 1
Untitled page
. . ~ Activities for Week 2
1. Create a new page by clicking on the Add s e
Page button. )f‘; ‘‘‘‘‘ e
2. Right-click on the new page sub-page and ;;
Copy
select -> Make Subpage from the menu. B pase
. . [% Copy Link to Page
3. The new page will be indented under the 22 MoveorCopy (CieAeM)
primary page. D New Page (Ctrl+N)
—2 Make Subpage
PO ST
@ Mark as Unread (Ctrl+Q)




Lesson 2

Notetaking Best
Practices

» Describe Best Practices for Notetaking

* Organize Notes with Tags and Keywords

e Search and Share Your Notes




Notetaking Best Practices

: Focus on capturing key ideas and essential information rather than trying
to write down everything verbatim.

: Rephrase the information in your own words to ensure you understand
it and to aid memory retention.

: Use headings, bullet points, and numbering to structure your notes and make
them easier to review.

: Incorporate diagrams, charts, and other visual elements to help illustrate complex ideas
and improve understanding.

: Look for any information that needs to be clarified.

: if others attended the meeting, ask them to review your notes and
confirm your understanding was the same as theirs.



Add Meeting Details

To search a notebook:

1. Create a new page in OneNote.
2. Click Home.

3. Click Meeting Details. The
Meeting Details pane displays.

4. Select the relevant meeting.

Once details are added, view the:
* Meeting date and time
* [nvitation message

« Participants - select each
participant to mark as present

¥} % Pendieton Course Notes - OneNote
Hifsiii Ifedrt DiF i Higtary Réwviw View  Help

; r ! B— =
o S = Bela alh e [ ]|[Eeees TIEED O E S
Paste - " o g i v 3 % " | Tobs Find Outlook Email Meeting || Dectate
<¥ Format Painter LN e £~ 4 = Heading 2 W et L) Tag Tags Tasks~ Page Details ~
Clipboard Barsic Text Styles o Tags Email | Meetings | voice
Notebooks * Fendleton +
v [l pom
Pendleton Course Nates|
I Pendleton Wednesday Februar 12 500 PR
Q, Search Notebooks v Meeting Details s
"
Topics v

“ Review Topics

Wed, Feb 12, 1:30 PM - Z:00 PM
Microsoft Teams Meeting

01:30 PM - 02:00 PM

Review Topics

Link to Outlook Ite .
ik to Mullook lem Modern Architectures

» Invitation Message 02:00 PM - 03:00 PM
« Participants (2)
[
] Trivia Challenge
02:00 PM - 03:00 PM

Notes




Share Meeting Notes Via Email

(o™ L%] = B %  Topics for Pendleton Courses - Message (HTML) jol = (]} b4
. . File Message Insert  Draw Options Format Text  Review Help
To share your notes via email: B [ | BT U LA )
1. Click Home.
B‘ To
2. Click Email Page. Send e
* An email is automatically created for you to © IntemahGeneral Purpase v
the people listed as participants. | 1
« All content from the OneNote page is Topics for Pendleton Courses
o o . Wednesday, February 12
inserted into the body of the email. 300 PM
Review M365 Topics for Pendleton
Wed, Feb12, 1:30PM-Z00PM A
Microsoft Teams Meeting
u @ “) ¥ Topics for Pendleton Courses - OneNote /O Search Link to Outlook Item X
Invitation Message v
Fil Home | Insert Draw History Review View Help |[ESticky Notes for
ﬁj A Calibri vt ovi= v = = 2 R é/ To Do (Ctrl+1) T? oo T 9 @/ V= @
paste. 1L B I Uab x,v £+ Av=v X W g mpotant (i) o find fege Email | Meeting |~ Dictate Transcribe = Copilot
v < Format Painter v 7 Ftl Outlook Tasks ¥ Page Details v ENNEge
Clipboard Basic Text Styles Tags Email Meetings Voice 5:2"6 Q\_,-
3 B s
5 Xl &




Add Tables, Files, Spread Sheets, and Images

In addition to text, from the Insert menu, you can add:
« Tables

* File Attachments

* Spreadsheets

e Pictures, etc.

Bl © Y = CourseObjectives - OneNote 2 Search = o p.d
File  Home Insert |Draw History Review View Help (# Sticky Notes | [SEUENE 2
1 ) b @J @ Lo —T @ )= EQ_, R @ — TT Equation ~ + =
- |EH E : 61+ g © = Lo U 5 Q .
Insert Table File File Spreadsheet Screen Pictures  Online Limk Loop Transcribe Record Date Time Date& Page Symbol Stickers Math
Space w Printout Attachment - Clipping A Video Components ~ w Video Time Templates ~ Assistant
Insert Tables Files Images Media Links Collaborate Recording Time Stamp Pagpes Symbols Bore Math pod
g = FTOJELT T
f Links and Nu.. Links
snmw ik
Course Objectives - : 2 o 2 A
| Pendleton ’ || Confirm the following objectives for the Individual Productivity course:
Topics for Pendleton Courses *  Prioritize and manage emails more effectively
= Search their email inboxes efficiently




Lesson 2

DEMO - Notetaking
Best Practices

Add Meeting Details

» Share Meeting Notes via Email

« Add Tables, Files, Spread Sheets and Images to a Page
» Search a Notebook

 Add Tags

* Search a Notebook for Tags

» Share a OneNote Notebook




Search a Notebook

To search a notebook:
1. Click the Search Notebooks
drop-down.

2. Select the notebook, section or
page you want to search.

3. Type the keyword or phrase.

4. Select the result or navigate to
the highlighted text.

OneNote can also search for text in a
PDF file or a graphic file.

File Home Insert Draw  History Review View Help

fﬁ [Calibrilight ~[20 +|2Z v 1T+ A

O
pPaste B I U x,+~ £~ A+ =+ %
¥ < Format Painter
Clipboard Basic Text
[ Add Page 3

Ei Wendy @ Tennessee...

P search

Heading 1
Heading 2
Styles

To Do (Ctrl+1)
i Impeortant (Ctrl+2)

Untitled page
l Mew Section 1

l Mew Section 2

+ MNew Section

L,

onday, December 29, 2025

10:39 AM

AN
*Q S
ToDo Find Outlook Email Meeting = Dictats
Tag  Tags Tasks~ Page Details ~
Email Meetings Vi

w

1

Mo matches: All Notebooks

Find on page (Ctrl+F)




Add Tags

To add a tag:

1. Put your cursor at the beginning of
the line of text you want to tag.

2. Click Home.

3. Click the Tags drop-down.

4. Select the appropriate tag.

u Z) ¥ Course Objectives - OneNote

File Home | Insert Draw

ﬁj |Calibri

History

5|
Paste B I U ab X, v 2 .
e «é? Format Painter
Clipboard Basic Text
L e Project Mgmt
l Links and Nu... Links

Course Objectives

Review View

v||11 oiZ e i=

=. % Styles

A

£ search

== A

Friday, September 2

1
firm the fo

Prioritize
Search tH
Use sche
Manage
Create, n
Utilize M
Take effe
Search a
Share no

[ ] Confirm the following objectives for the Individual Productivity course:
Prioritize and manage emails more effectively
Search their email inboxes efficiently

1)

Tags - i
To Do (Ctrl+1) Ft' J

B -0 @2 RN

Important (Ctrl+2)
Question (Ctrl+3)

Remember for later

ectiy
Highlight (Ctrl+6)

eting
Contact (Ctrl+7) hin th
Address (Ctrl+8)

ing a
Phone number (Ctrl-
Web site to visit

and
Idea
Password
Critical
Project A

s

Customize Tags...




Search a Notebook for Tags

To search a notebook for tags:

1. Click Home.
2. Click Find Tags. The Tags Summary pane displays.

3. Select a tag from the list to open the page that contains that tag.

Ec: Find Tags

Fil Home | Insert Draw History Review View Help
EF] f Calibri i diEv =y == A é/ To Do (Ctrl+1)
& —
Paste B I U a x,v £+ A+ =+ X Styles W Important (Ctrl+2)
v <& Format Painter ¥
Clipboard Basic Text Styles Tags

"] H3 Outlook Tasks v

[# Sticky Notes | FSESLEICRS

Tags Summary v

eSearch completed
Group tags by:
Tag name

[ show only unchecked items
|| Compliance Training

Content indudes:

Course Presentation

Course Presentation

Course Presentation Student Ha..

Course Presentation Student Ha_.

Create a Mew Bill-To for an Existi...

| Create a new or additional ship-t..

[ | Create a New Payer for an Existin...

| Create a new sold-to - new cust._

I+ Create Beta issue log.

Search:
This notebook -

[E Refresh Results

[Z] Create Summary Page




Share a OneNote Notebook

To share your notes via email:

, - o X
1. Click the Share drop-down.
2. Select Share Entire Notebook. L Siék‘f Nﬁt&*@ &
3. Select the person to share the notebook Q seal] 2 Share Entire Notebook
with or enter their email address. @ Copy Link tg Notebook
. Share
Enter a message, if necessary. f ) Email Page e
5. Click Edit to change the sharing {8 Manage Access... - . ?y y
permissions, if necessary. ‘ N\ S

/

6. C“Ck Send, / B Here are my notes from today's meeting,

To share your notebook via a link, from the Share drop-down, select Copy

: 6
Link to Notebook. oo :I
o G2 Copy link | & B Send

You can then paste this link into a chat, channel conversation, email, etc.




Lesson 3

Discover Planner
Functionality

* Access and Navigate Planner
* Create a Plan
* Create and Manage Buckets and Tasks

e Use Planner Views (Formats)




What is Planner? ‘

Planner is Microsoft’s planning application, designed to help you stay on track, manage your
tasks, to-dos, plans, and projects, all in one place.

» Use for personal and/or teamwork task planning
» Collaborate with your team about plans and tasks
* Provides visibility to track workload and progress

» Display charts and discuss with your team task
status

Organize your workload

* Create a plan

Invite your team

Assign project tasks

Drag and drop tasks
Attach files




How to Access Planner

You can access Planner from Teams or from a web browser.

From Teams:

* Click the View more apps (3 dots) icon.
» Click the Planner App.

« Click Add.

@ Team: Q

ety

@ Unread

Chat

e % Di

i N

Teams @  Mentions

Calendar Q_ Search pp:

%.

Calls

o ® |4

OneDrive @  Planner Por PowerPol

»® ¥
Q, planner

7 I

@ ¢ ..

Privacy, Permissions

Get more apps

From the Web:
 Type Office 365 into your internet browser, M365
Copilot opens.

* From the Navigation Pane select Apps and then
select Planner.

Use across Teams, Outlook, and Microsoft 365 Copilot

@  Bookings ‘ji Org Explorer | Powersl @  Welcome Guide.
(="
i Create
Get work done
l & Apps I

e o [
Q se: APPS
O

L 2 a & W daa Excel @& PowerPoint &

,,,,,,,,,,

 w @ OneDri @ & a &

L




Lesson 3

DEMO - Discover
Planner Functionality

Access Planner

» Create aPlan

* Planner Screen Overview

» Create and Edit Buckets

* Organize Tasks

« Add Additional Information to Tasks

 Schedule View




Create a Plan

Create a new plan or use a template and make it your own.
1. Select the Planner app.

2. Click + New Plan, |+ tewran o : )
3. Select a template and click Use Template.
4. Enter a name for the plan and add to an existing channel.
5. Click Create. ey , wE -
= 4 Q )

< Create a plan from a template <

' 4 —
o v “/
Simple Plan Project Management MName *

M3 56 Project Plan

Add to my pinned plans

M365 Training Team X

To create your own plan from scratch, click + Basic instead of choosing a
template. Plans can be copied by selecting the radio button Use an exiting

Create

plan from this team and selecting a plan from the dropdown.




Planner Overview Screen

A? ‘ Planner = My Plans > [ M356 Project Plan ~ # B Grid  §8 Board Schedule  (§j Charts &P Timeline - & share v @
g ‘O- My Day Q = Filters ~ [= Group by Bucket
553 ) My Tasks Backlog Up next In progress Blocked Completed Ad
T 92 My Plans -+ Add task ~+ Add task -+  Add task -+ Add task ~+ Add task
* Pt () Assign tasks (O Add additional information to tasks Pink | REEE) () CreateaPlan
el Pinned ) add duraticn () Customize buckets »
) ) 11724 5 O Add attachments )
() Add effort
c%:: -Z:Z- Add dependencies
r6 Add a checklist
Branner Qos
& 11720
Aqua
e (O Add new tasks
1713
 Grid - List of Tasks
» Board - create buckets or groups of tasks, for example, Phase 1, Phase 2
 Schedule - calendar of tasks
« Charts - displays the progress of tasks in different types of graphs




Create and Edit Buckets

A Planner Bucket is a vertical column that helps organize tasks into categories like phases, types of
work, or departments.

Buckets can be used to represent different stages of a project, for example, scope, progress, or training.

My Plans > a M356 Project Plan ~ M G &® Board Schedule &) Charts 4P Timeline - e Management
Acd task

« Select Board. T A
» Scroll far-right, click Add a new Bucket.
» Enter a name for the bucket. Fos s sl
* Buckets are ready for you to add tasks Set due date
e Click + Add task. Co Assign

* Select a due date.

* Assign to staff.
e Click Add task.




Organize Tasks

« Tasks can only be in one bucket at a time, but you can
drag and drop tasks between buckets.

« After adding tasks, you can sort them into buckets to
help break things up into phases, types of work,
department, or whatever makes the most sense for your
plan.

* You can also drag the title of a bucket to a new position
to change the order of buckets.

 When a task is assigned to a team member or closed by
a manager a notification is received by the team
member via Outlook.

Management

~+ Add task

() Phasel

<7 Label

So Assign

O Copy task

e Copy link to task
— Move task

W Delete

Add task

@ O

~ FaQs for Word and Outlook to add to
doc




Add Additional Information to Tasks

To add additional information to a task in Microsoft Planner, click on the task you want to update.

- X

M356 Project Plan

N

) Add additional information to tasks

The task details pane opens. & rsisn
* You can enter a description, add a checklist, attach j{:waw . o
files or links, and include comments for ongoing Up next ¥ (o o e .
discussions. Start date Due date Repeat
Start anytime 11/20/2025 2 Does not repeat v
* You can also assign the task to team members, set a ST
due date, and add labels for better categorization. pas cesrpRn o ad e

* These features help ensure all relevant information is
easily accessible to anyone working on the task.

' Checklist 0 /7 B show on car d

O Add duration

() Add attachments
(O Add labels

(O Add effort

(O Add dependencies

(O _add notes




Track Progress

Click the Charts tab at the top to view progress in Planner by Status, Bucket, Priority and Member
Assigned tasks.
g My Plans > (@) M356 ProjectPlan « # @ Grid [ Board Ds:recmane S share v @

Q = Filters ~ [= Group by Bucket

Status Priority Tasks

+  Add task

5 Backlog -~

() Assign tasks

It is very important for gy ' B .
members to update the :
status of their tasks, for s , o

information to be accurate to P I =

assess if the plan is on track.

Mediu. Low
W notstarted [ InProgress [l Late [ Completed M notstarted [ InProgress [l Late [ Completed
& 1113
Members
In progre: o
6

() Customize bucket
& 1111

u

" Blocked ~

M notstarted [ nerogress [l Lete [ Completed




Schedule View

The Schedule view in Planner provides a calendar-based perspective of your tasks, allowing you to
visualize deadlines and task distribution over time.

My Plans > (@) M356 Project Plan +~ # B9 Grid D Board @@ Schedule 5 Charts P Timeline - S share v | @
Q = Filters ~ [= Group by Bucket
< > MNovember 2025 Hide future recurring tasks (@ ) Week Month Unscheduled tasks
Sunday Monday Tuesday Wednesday Thursday Friday Saturday + Add task
1
Backlog ~
Up t ~
2 3 4 [ 7 8
In progre: ~
Blocked ~
9 10 11 12 13 14 15
Customize buckets Add new tasks
Completed ~
16 17 18 19 20 21 22 Management ~
Add additional informatio...
() Phase1

Tasks with assigned due dates are displayed on a calendar.




Quick Recap

Overview of Microsoft OneNote
Notetaking Best Practices
Overview of Microsoft Planner

Benefits of sing Planner for Task Management




QUESTIONS?



THANK YOU
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